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Overview 

Panasonic’s new PAN1326C2 is a Host Controller 

Interface (HCI) Bluetooth® Radio Frequency (RF) 

module that brings Texas Instruments™ seventh 

generation Bluetooth core integrated circuit, the 

CC2564C, to an easy-to-use module format. The 

PAN1326C2 is Bluetooth 5 compliant and it offers 

best-in-class RF performance with about twice the 

range of other Bluetooth Low Energy (LE) solutions. 

Panasonic’s tiny footprint technology has produced a 

module of only 85.5 mm². The module is designed to 

accommodate PCBs pad pitch of 1.3 mm and as few 

as two layers for easy implementation and 

manufacturing. The module has been designed to be 

100 percent pin compatible with previous 

generations of Texas Instruments based Bluetooth 

HCI modules. 

 Features 

• Bluetooth 5 compliant up to the HCI layer 

• Best-in-class Bluetooth RF performance (Tx, Rx 
sensitivity, blocking) 

• Dimensions: 9 mm × 9.5 mm × 1.8 mm 

• Based upon Texas Instruments CC2564C 

• Interfaces: UART, GPIO, PCM 

 

Characteristics 

• Bluetooth 5 

• Receiver sensitivity: -90 dBm 

• Output power: 8 dBm 

• Power supply: 1.7 V to 4.8 V 

• Power consumption: Tx 40 mA 

• Operating temperature range: -40 °C to 85 °C 
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By purchase of any of the products described in this document the customer accepts the document's 

validity and declares their agreement and understanding of its contents and recommendations. Panasonic 

Industrial Devices Europe GmbH (Panasonic) reserves the right to make changes as required at any time 

without notification. 

© Panasonic Industrial Devices Europe GmbH 2021. 

This document is copyrighted. Reproduction of this document is permissible only if reproduction is without 

alteration and is accompanied by all associated warranties, conditions, limitations, and notices. Do not 

disclose it to a third party. 

All rights reserved. 

This Quick Start Guide does not lodge the claim to be complete and free of mistakes. 

 

The information contained herein is presented only as guidance for Product use. No responsibility is 

assumed by Panasonic for any infringement of patents or any other intellectual property rights of third 

parties that may result from the use of Product. No license to any intellectual property right is granted by 

this document, whether express or implied, by estoppel or otherwise. 

Description of hardware, software, and other information in this document is only intended to illustrate the 

functionality of the referred Panasonic product. It should not be construed as guaranteeing specific 

functionality of the product as described or suitable for a particular application. 

Any provided (source) code shall not be used or incorporated into any products or systems whose 

manufacture, use or sale is prohibited under any applicable laws or regulations. 

Any outlined or referenced (source) code within this document is provided on an “as is” basis without any 

right to technical support or updates and without warranty of any kind on a free of charge basis according 

to § 516 German Civil Law (BGB) including without limitation, any warranties or conditions of title, non 

infringement, merchantability, or fitness for a particular purpose. Customer acknowledges that (source) 

code may bear defects and errors. 

The third party tools mentioned in this document are offered by independent third party providers who are 

solely responsible for these products. Panasonic has no responsibility whatsoever for the performance, 

product descriptions, specifications, referenced content, or any and all claims or representations of these 

third party providers. Panasonic makes no warranty whatsoever, neither express nor implied, with respect 

to the goods, the referenced contents, or any and all claims or representations of the third party providers. 

To the maximum extent allowable by Law Panasonic assumes no liability whatsoever including without 

limitation, indirect, consequential, special, or incidental damages or loss, including without limitation loss of 

profits, loss of opportunities, business interruption, and loss of data. 
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1 About This Document 

1.1 Purpose and Audience 

This Quick Start Guide provides details on how to start developing applications on the 

Panasonic PAN1326C2 module: 

• Installing toolchain, 

• Setting up the demo “iBeacon (Bluetooth Low Energy)” demo by using Panasonic 
development kit and receive beacon data in app, and 

• Setting up the demo “SPP (Bluetooth Classic)” by using Panasonic development kit and 
transmit strings from terminal to application via PAN1326C2. 

It is intended for research and developement engineers.  

The product is referred to as “the PAN1362C2” or “the module” within this document. 

 

1.2 Revision History 

Revision Date Modifications/Remarks 

1.0 2021-05-31 First version 

 

1.3 Use of Symbols 

Symbol Description 

 

Note 

Indicates important information for the proper use of the product. 

Non-observance can lead to errors. 

 

Attention 

Indicates important notes that, if not observed, can put the product’s functionality 

at risk. 

 

Tip 

Indicates useful information designed to facilitate working with the software. 

 [chapter number] 

[chapter title] 

Cross reference 

Indicates cross references within the document. 

Example: 

Description of the symbols used in this document  1.3 Use of Symbols. 

✓ Requirement 

Indicates a requirement that must be met before the corresponding tasks can be 

completed. 

➔ Result 

Indicates the result of a task or the result of a series of tasks. 
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Symbol Description 

This font GUI text 

Indicates fixed terms and text of the graphical user interface. 

Example: 

Click Save. 

Menu > Menu item Path 

Indicates a path, e.g. to access a dialog. 

Example: 

In the menu, select File > Setup page. 

This font File names, userinput 

Indicates file names or messages and information displayed on the screen or to 

be selected or entered by the user. 

Examples:  

pan1760.c contains the actual module initialization. 

Enter the value Product 123. 

This font Systemoutput 

Indicates messages and information displayed on the screen. 

Example:  

The message Failed to save your data is displayed. 

Key  Key 

Indicates a key on the keyboard. 

Example: 

Press F10 . 

 

1.4 Related Documents 

For related documents please refer to the Panasonic website  6.2 Product Information. 
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2 Overview 

Panasonic’s new PAN1326C2 is a Host Controller Interface (HCI) Bluetooth RF module that 

brings Texas Instrument’s seventh generation Bluetooth core integrated circuit, the CC2564, to 

an easy-to-use module format. The PAN1326C2 is Bluetooth 5 compliant and it offers 

best-in-class RF performance with about twice the range of other Bluetooth LE solutions. 

Panasonic’s tiny footprint technology has produced a module of only 85.5 mm². The module is 

designed to accommodate PCBs pad pitch of 1.3 mm and as few as two layers for easy 

implementation and manufacturing. The module has been designed to be 100 percent pin 

compatible with previous generations of Texas Instruments based Bluetooth HCI modules. 

 

For related documents please refer to  6.2 Product Information. 
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3 Setting up the Toolchain 

The following guide is based on a Windows 64-Bit desktop version and CCSTUDIO single file 

installation. 

 

3.1 Installing “CC2564CMSP432BTBLESW1” 

The following requirement must be met: 

✓ Account at Texas Instruments (https://www.ti.com) 

 

1. Go to https://www.ti.com/tool/CC2564CMSP432BTBLESW and download 

CC2564CMSP432BTBLESW1.

 

2. Start and install the downloaded file setup.exe.  

The executable file has installed all the necessary drivers, libraries, and code examples 

to develop Bluetooth applications on MSP432 MCUs. 

 

Now the “CC2564CMSP432BTBLESW1” is installed. 

 

3.2 Installing “Code Composer Studio” 

The following requirement must be met: 

✓ Account at Texas Instruments (https://www.ti.com) 

 

1. Go to https://www.ti.com/tool/CCSTUDIO and download the “Code Composer Studio“. 

There are two options available, the desktop version (CCSTUDIO) and cloud version 

(CCSTUDIO-CLOUD). 

 
 

https://www.ti.com/
https://www.ti.com/tool/CC2564CMSP432BTBLESW
https://www.ti.com/
https://www.ti.com/tool/CCSTUDIO
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CCSTUDIO can be downloaded as “single file” or “on-demand”. If you 
do not want interference with your installed anti-virus program, then it 
is recommended to use the single file installer. 

 

2. Extract the downloaded file CCS10.x.x.xxxxx_win64 and locate the file 

ccs_setup_10.x.x.xxxxx.exe in the extracted folder.  

3. Start and install the setup.  

If you want to install specific devices to save disk space, choose Recommended 

Installation, otherwise choose Full Installation. 

4. Select the component SimpleLink MSP432 low power + performance MCUs (1) for 

applications with PAN1326C2 and TI EVK (Texas Instruments evaluation kit).

 

5. Click Next > (2) and complete the setup by following the instructions. Leave the debug 

probes selection as it is. 

 

Now the “Code Composer Studio” is installed. 

 

3.3 Starting “Code Composer Studio” 

 

Before starting programming, always update “Code Composer Studio” and the 
compilers to the newest version. 

 

The following requirements must be met: 

✓ The “CC2564CMSP432BTBLESW1“ is installed  3.1 Installing 

“CC2564CMSP432BTBLESW1”. 

✓ The “Code Composer Studio“ is installed  3.2 Installing “Code Composer Studio”. 
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1. Start Code Composer Studio.  

2. Choose the location for your workspace. 

 

The path to your workspace must include only alphanumeric 
characters to avoid compiler errors in some examples.  

The default workspace by “Code Composer Studio” includes always 
an underline “_”. Change the name of the workspace or create a new 
one without special characters. 

 

3. Click the tab Help (1) > Check for Updates (2) to update “Code Composer Studio” and 

the compilers to the newest version. 

 

➔ The updating process will start. 

4. After the updating process is completed: Go to the page Getting Started and click 

Import Project. 

Alternatively click the tab File > Open Project from File System. 

 

 

Choose only projects from the folder “Code Composer Studio” 
because “Code Composer Studio” ist used. 
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4 Setting up the Demo 

 

Two different demos can be set up: 

• “iBeacon” which is based on Bluetooth Low Energy. 

• “SPP“ which is based on Bluetooth Classic. 

 

This chapter explains how to set up the demos: 

• “iBeacon (Bluetooth Low Energy)” by using Panasonic development kit and receive 
beacon data in app. 

• “SPP (Bluetooth Classic)” by using Panasonic development kit and transmit strings from 
terminal to application via PAN1326C2. 

 

To set up the demo, the following steps must be done: 

1.  4.1 Loading the Demo 

2.  4.2 Connecting the Evaluation Board 

3.  4.3 Flashing the Code 

4. For the demo “iBeacon (Bluetooth Low Energy)” please refer to  4.4 Setting up 

“iBeacon (Bluetooth Low Energy)”,  

for the demo “SPP (Bluetooth Classic)” please refer to  4.5 Setting up “SPP (Bluetooth 

Classic)“. 

 

4.1 Loading the Demo 

1. Go to C:\ti\Connectivity\CC256X BT\CC256x MSP432 Bluetopia 

SDK\v4.2.1.1\Samples\XXXX and load the demo (iBeaconDemo or SPPDemo). 

2. Click the tab Project > Properties. 
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3. Make sure that the box Manage the project’s target-configuration automatically (2) 

is checked. 

 

4. Click Apply and Close (2). 

5. Open the source code file (iBeaconDemo.c or SPPDemo.c) in the application file of the 

project. 

6. Go to line 166. Change 0x4c to 0x3a and change 0x00 to 0x00 (Panasonic Company 

ID:0x003A) to change the manufacturer name of the Bluetooth Beacon. 

Keep the little-endian byte format in mind (LSB first). 

 

7. Press CTRL  + S  to save the changes. 

 

Now the demo is loaded. 
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4.2 Connecting the Evaluation Board 

The following requirement must be met:  

✓ The demo is loaded  4.1 Loading the Demo. 

 

1. Connect the evaluation board as shown in the picture. 

 

2. Connect the evaluation kit to the PC. 

 

Now the evaluation board is connected. 

 

4.3 Flashing the Code 

The following requirements must be met: 

✓ The demo is loaded  4.1 Loading the Demo. 

✓ The evaluation board is connected  4.2 Connecting the Evaluation Board. 

 

1. Click the icon  “Debug” to compile the code and flash it onto the microcontroller. 

 

2. If you are asked for a firmware update: confirm the update. 

 

Always keep the firmware updated, otherwise some applications will 
not work. 

 

➔ The compilation is finished and loaded into the microcontroller. 

3. Click the icon  “Run” to execute the application. 
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Now the code is flashed. 

 

For the demo “iBeacon (Bluetooth Low Energy)” please refer to  4.4 Setting up “iBeacon 

(Bluetooth Low Energy)”. 

For the demo “SPP (Bluetooth Classic)” please refer to  4.5 Setting up “SPP (Bluetooth 

Classic)“. 

 

4.4 Setting up “iBeacon (Bluetooth Low Energy)” 

This chapter explains how to set up the demo “iBeacon” which is based on Bluetooth Low 

Energy. 

 

The following requirements must be met: 

✓ The demo is loaded  4.1 Loading the Demo. 

✓ The evaluation board is connected  4.2 Connecting the Evaluation Board. 

✓ The code is flashed  4.3 Flashing the Code. 

 

Starting “TI SimpleLink Starter” 

1. Download the application TI SimpleLink Starter from the Apple® App Store or Google 

Play Store. 

2. Open the application TI SimpleLink Starter. 

➔ The device Matsushita Electric Industrial Co. Ltd iBeacon with the 

UUID E2C56DB5-DFFB-4848-D2B0-60D0F5A71096 is displayed. 

 

 

Now the demo “iBeacon (Bluetooth Low Energy)” is set up. 
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4.5 Setting up “SPP (Bluetooth Classic)“ 

This chapter explains how to set up the demo “SPP” which is based on Bluetooth Classic. 

 

The following requirements must be met: 

✓ The demo is loaded  4.1 Loading the Demo. 

✓ The evaluation board is connected  4.2 Connecting the Evaluation Board. 

✓ The code is flashed  4.3 Flashing the Code. 

 

Setting the Evaluation Board as Server 

1. Download a Serial terminal program. In this guide “PuTTY“ is used. 

2. Open the terminal program and select the connection type Serial. 

3. Set the assigned COM port to the evaluation board (in this case “COM4”) and set the 

speed to 115 200 kBit/s.  

4. Enter Server in the prompt Choose Mode> (1) to set the evaluation board as server. 

 

5. Entering Open 1 in the prompt Server> (2) to open a server port. 

 

You can replace “1” with any number between 1 and 30, if there is no 
server open on that port. 

 

➔ The evaluation board is set as server. 
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Pairing the Device with the Evaluation Board  

6. Go to the Bluetooth settings on your smartphone and press SPPDemo to pair with the 

device. 

 

7. Type in a random PIN (for example 0000) and confirm it. 

➔ The smartphone will send a PINCodeRequest (1) to the terminal. 

 

8. Enter PINCodeResponse 0000 in the prompt Server> (2) to confirm the 

PINCodeRequest.  

➔ The smartphone is paired with the evaluation board. 

 

Connecting to the SPPDemo Device 

9. Download a Bluetooth terminal on your smartphone. In this guide “Serial Bluetooth 

Terminal” by Kai Morich is used.  

10. Open the serial Bluetooth terminal. 

11. Press the icon  “menu” and go to Devices. 
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12. Press SPPDemo to connect to the SPPDemo device. 

 
 

Now the demo “SPP (Bluetooth Classic) is set up and strings from terminal to smartphone and 

vice versa can be sent ( Sending Strings from Terminal to Smartphone and vice versa). 

 

Sending Strings from Terminal to Smartphone and vice versa 

1. Type in read in the prompt Server> (1) to read out the buffer.

 

2. Type in write in the prompt Server> (2). 
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➔ The hardcoded string This is a test string. will be sent to the smartphone. 
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5 Restricted Use 

5.1 Life Support Policy 

This Panasonic Industrial Devices Europe GmbH product is not designed for use in life support 

appliances, devices, or systems where malfunction can reasonably be expected to result in a 

significant personal injury to the user, or as a critical component in any life support device or 

system whose failure to perform can be reasonably expected to cause the failure of the life 

support device or system, or to affect its safety or effectiveness. 

Panasonic customers using or selling these products for use in such applications do so at their 

own risk and agree to fully indemnify Panasonic Industrial Devices Europe GmbH for any 

damages resulting. 

 

5.2 Restricted End Use 

This Panasonic Industrial Devices Europe GmbH product is not designed for any restricted 

activity that supports the development, production, handling usage, maintenance, storage, 

inventory or proliferation of any weapons or military use. 

Transfer, export, re-export, usage or reselling of this product to any destination, end-user or any 

end-use prohibited by the European Union, United States or any other applicable law is strictly 

prohibited. 
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6 Contact Details 

6.1 Contact Us 

 

Please contact your local Panasonic Sales office for details on additional product options and 

services: 

 

For Panasonic Sales assistance in the EU, visit 

https://eu.industrial.panasonic.com/about-us/contact-us 

Email: wireless@eu.panasonic.com 

 

For Panasonic Sales assistance in North America, visit the Panasonic website 

“Sales & Support” to find assistance near you at 

https://na.industrial.panasonic.com/distributors 

 

 

 

Please visit the Panasonic Wireless Technical Forum to submit a question at  

https://forum.na.industrial.panasonic.com 

 

 

 

6.2 Product Information 

 

Please refer to the Panasonic Wireless Connectivity website for further information on our 

products and related documents: 

 

For complete Panasonic product details in the EU, visit 

http://pideu.panasonic.de/products/wireless-modules.html 

 

For complete Panasonic product details in North America, visit 

http://www.panasonic.com/rfmodules 

https://eu.industrial.panasonic.com/about-us/contact-us
mailto:wireless@eu.panasonic.com
https://na.industrial.panasonic.com/distributors
https://forum.na.industrial.panasonic.com/
http://pideu.panasonic.de/products/wireless-modules.html
http://www.panasonic.com/rfmodules
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